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How Warehouse Connector Works

Warehouse Connector collects meta and events from Decoder and Log Decoder and writes them in
AVRO format into a Hadoop-based distributed computing system. You can set up the Warehouse
Connector as a service on existing Log Decoders or Decoders.

The Warehouse Connector contains the following components:
* Data Source
e Destination

¢ Data Stream

Data Source

Warehouse Connector collects data from the data source to store it in the destination. The supported data
sources are Log Decoder and Decoder.

Destination

Destination is the Hadoop-based distributed computing system that collects, manages, and enables
reporting on security data. The following are the supported destinations:

* NetWitness Warehouse (MapR) deployments
e HortonWorks Data Platform

e Any Hadoop-based distributed computing system that supports WebHDFS or NFS mounting of
HDES file systems.
Example: Commercial MapR M5 Enterprise Edition for Apache Hadoop

Data Streams

A data stream is a logical connection between the data source and destination. You can have multiple
streams for different subsets of data collected. You can setup streams to segregate data from multiple
Decoder and Log Decoder services. You can create a stream with a single data source and destination or
with multiple data sources and a single destination.

The Warehouse Connector:

* Aggregates session and raw log data from Decoders and Log Decoders.

e Transfers the aggregated data to supported destinations like Hadoop based deployments.
e Serializes the aggregated data that includes both schema and data into AVRO format.

Meta Filters

Meta filters enables you to filter the meta keys that should be written into the Warehouse. For more
information, see Specify Meta Filters for a Stream.
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Multi-Valued Meta Keys

NetWitness Warehouse supports multi-valued meta keys. The multi-valued meta keys is the meta field
with the array type. You can use the meta keys library to determine the meta fields of type array and
write HIVE queries with the correct syntax for arrays. By default, the following meta keys are treated as
multi-valued and are defined in the file, multivalue-bootstrap.xml located at /etc/netwitness/ng in the
Warehouse Connector:

e alias.host

e action

e username

* alias.ip

e alias.ipv6

e email

o device.group

e event.class

Checksum Validation

You can validate the file integrity of the AVRO files that are transferred from the Warehouse Connector
to the data destinations. You need to enable checksum validation option when you configure the
Warehouse Connector.

Lockbox Support

Lockbox provides an encrypted file that Warehouse Connector uses to store and protect sensitive data.
You need to create the lockbox by providing a lockbox password while configuring the Warehouse
Connector for the first time.

Note: You can orchestrate Warehouse Connector on a Log Decoder or a Decoder appliance.

The following is an overview on how to install and configure the Warehouse Connector service on Log
Decoder or Decoder.

* Configuring the Warehouse Connector service on NetWitness,
* Configuring data sources,

e Destinations,

e Streams for Warehouse Connector,

» Configuring alert notifications on NetWitness.

Note: NetWitness Platform has added a Health & Wellness stat for Warehouse Connector to indicate
the status of its Lockbox. Also, an out-of-the-box rule has been added so that a Health & Wellness
alarm is raised when the Lockbox does not exist or cannot be opened.

Warehouse Connector Configuration 5
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Install Warehouse Connector | Configure a Warehouse

Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder

Configure Destination ERERE
using NFS, SFTP, and

WebHDFS

Create a Lockbox

Analyze a Warehouse
Configure the Data Source Configure a Stream Repart

for Warehouse Connector
Create a Stream

Update the Port Number
and SSL Settings of the
Data Source

Finalize the Stream

Start the Stream

Meonitor a Warehouse
Connector |

| Manage a Stream and
Lockbox

Edit a Stream

Reload the Stream

Specify Meta Filters for
a Stream

Define Multi-valued
| Metas

Change or Refresh |
| | Lockbox |

To install and configure the Warehouse Connector service, perform the following:

1. Install Warehouse Connector Service on a Log Decoder or Decoder or Hybrid

Configure a Warehouse Connector Service

Configure the Data Source for Warehouse Connector

Configure the Destination

Configure a Stream

Monitor a Warehouse Connector

Add Warehouse as a Data Source to Reporting Engine

Analyze a Warehouse Report

A S AN L R o B

Manage a Stream
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Install Warehouse Connector Service on a Log

Decoder or Decoder or Hybrid

To install (fresh install) the Warehouse Connector service on a Log Decoder or Decoder or Hybrid:
1. Log in to NW Admin server

2. Enter the following command on NetWitness Server:
warehouse-installer --help
The command line interface (CLI) usage descriptions are displayed.

3. Install Warehouse Connector service by executing the following command:
warehouse-installer --host-key <ID, IP address, hostname or display name of
Decoder, Log Decoder, or Hybrid host>

4. Restart the Warehouse Connector using following command:

service nwwarehouseconnector restart

The Warehouse Connector service is successfully installed on the Log Decoder or Decoder or Hybrid.

Note: If you have custom-defined host entries in /etc/hosts, make sure to have the same entires in
/etc/hosts.user. Run the following command to ensure that the host names are updated in this

installation:
nw-manage —--refresh-host --host-key <ID, IP, hostname or display name of

host>
For more information, see "Manage Custom Host Entries in /etc/hosts" in the System Maintenance
Guide.

Install Warehouse Connector Service on a Log Decoder or Decoder or Hybrid 7
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Configure a Warehouse Connector Service

You can configure the Warechouse Connector service using the following procedure.

To set the Lockbox password:

1. Log on to NetWitness.
——
2. Go to Kl (Admin) > Services.
3. In the Services view, select the added Warehouse Connector service, and select i > View
> Config.
4. In the Services Config view of Warehouse Connector, click the Lockbox Settings tab.
NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY
-+ Change Service | decoder - Warehouse Connector | Config
Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration
Create New Lockbox
Set the lockbox password. The password should satisfy lockbox password strength.You will be required to enter this password to perform any lockbox management.
Lockbox Password il
Confirm Lockbox Password il
Change Lockbox Password
Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password ok
New Lockbox Password AR
Confirm New Lockbox Password =~ ########
Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.
Lockbox Password R
5. In the Create New Lockbox section, perform the following:
a. In the Lockbox Password field, enter the new lockbox password.
Note: The lockbox password must be at least eight characters in length and it must contain at
least three of the following groups: one uppercase character [A-Z], one lowercase character [a-
z], one numeral [0-9], and one special character.
b. In the Confirm Lockbox Password field, enter the added lockbox password to confirm.
c. Click Apply.
The Lockbox password is set.
8 Configure a Warchouse Connector Service
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Configure the Data Source for Warehouse Connector

There are two procedures for configuring the data source for the Warehouse Connector:
1. First, you must configure the data source.

2. Then, you need to update the Port Number and SSL Settings for the Data Source.

Configure the Data Source

To configure the data source:

1. Log on to NetWitness.

QA
2. Goto (Admin) > Services.
o R

3. In the Services view, select the added Warehouse Connector service, and select > View >
Config.

The Services Config view of Warehouse Connector is displayed.

4. On the Sources and Destinations tab, in the Source Configuration section, click +

Available Services

59’ Name ~ Address Type
59’ Decoder Decoder
59’ Log Decoder Log Decoder

Cancel 0K

Configure the Data Source for Warehouse Connector 9
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5. In the Available Services dialog, select the Log Decoder or Decoder services that you want to add as
a source to the Warehouse Connector service and click OK.
The selected Log Decoder and Decoder services are listed in the Source Configuration section.

Update the Port Number and SSL Settings of the Data Source

If there is change to the port number or SSL settings of the Warehouse Connect data sources, you can
update the changes in Explore view of the Warehouse Connector.

Make sure that:

e You have the changed port number or SSL settings of the data source.

* You have stopped the streams related to the data source that is updated with the port number or SSL
settings.

To update the port number or SSL settings:

1. Log on to NetWitness.

QA
2. Goto (Admin) > Services.
[ XE

3. In the Services view, select the added Warehouse Connector service and select > View

> Explore.

The Service Explore view of Warehouse Connector is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports E admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

-+ Change Service | decoder - Warehouse Connector |  Explore &

/decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

=decoder - Warehous...

B & decoder - Warehouse Connector (WARE...

connections

deviceappliance

B[ connections
logs

&[] deviceappliance

B[ logs

B rest

B[ Jservices

rest

services

storedproc

sys

B[ storedproc users

B[ 0sys warehouseconnector
B[Jusers

& [Jwarehouseconnector

»

4. Navigate to warehouseconnector/sources, right-click the source, and click Properties.
The Properties of the source is displayed.

10 Configure the Data Source for Warehouse Connector
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NETWITNESS

Investigate ~ Respond ~ Users  Hosts  Files

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

% ChangeService |  decoder - Warehouse Connector | Explore

Zdecoder - Warehous...
& decoder - Warehouse Connector (WAREH.
&[T connections
&[] deviceappliance
e[ Jlogs
B rest
B [Jservices
£ [Jstoredproc
B[ sys
B[ Jusers

5 & warehouseconnector
Properties

!

connections
deviceappliance
logs

rest

services
storedproc

sys

users

warehouseconnector

Dashboard Reports

SYSTEM SECURITY

decoder - Warehouse Connector

In the drop-down menu, select update. In the Parameters field, perform the following:

admin v

» To update the port number of the source, enter port=<new source portnumber> and click

Send.

Parameters port=443

Send ‘

» To update the SSL settings of the source, enter ssl=<new ssl settings> and click Send.

Parameters ssl=on

Send ‘

Note: You can also update the port number and ssl settings simultaneous by adding space
between the parameters.

Parameters port=443 ssl=on

6. Restart the Warehouse Connector service.

7. Start the streams.

Configure the Data Source for Warehouse Connector
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Configure the Destination

You can configure the destination using NFS, SFTP, and WebHDFS. Change the destination to which
the Warehouse Connector service needs to write the collected data using NFS:

* NetWitness Warehouse (MapR) deployments
e Commercial MapR M5 Enterprise Edition for Apache Hadoop deployments

You can configure the Warehouse Connector to write to a remote destination using Secure File Transfer
Protocol (SFTP). The remote destination can be a remote server that is NFS mounted to the MapR
cluster or it can be a remote staging server.

By default, in the remote destination the Warehouse Connector writes data in the following directory
structure:

e /<staging
folder>/rsasoc/vl/sessions/data/<year>/<month>/<day>/<hour>/

*» /<staging folder>/rsasoc/vl/logs/data/<year>/<month>/<day>/<hour>/
Where <staging_folder> is the folder on the remote server where the Warehouse Connector writes the
data.

If you are using a remote staging server as the remote destination, you need to manually copy or move
the directory structure to any of the following deployments:

* NetWitness Warehouse (MapR)

e Commercial MapR M5 Enterprise Edition for Apache Hadoop

e HortonWorks HD

To generate reports from the data written by Warehouse Connector, make sure that in your

Hadoop deployment you maintain a similar directory structure that is created by Warehouse Connector in
the remote destinations.

12 Configure the Destination
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The following illustration describes how you can use SFTP to write data from Warehouse Connector to a
remote destination.

|

!

i | |
WC writes data in the *Directory I l !H | |
Structure mentioned below I I L I I

| | [ |

I : i

FS Mounted————»| e i

Reportin
| MapR Cluster pEring
| Maintain the *Directory Structure |

|

|

|

|

|

|

|

|

| |

| | |
| as mentioned below | |
| | |
|

|

|

|

|

|

|

|

|

Remaote perver

[

i

[

i

[

Warehouse !
Connector (WC) ————5FTP I
|

i

i

[

i

i

| Reporting Engine

! Reporting

i-\;_‘, Manuallvfh‘pgrammaticallv
SFTP . DB/ AR Klin Gata | MapR Cluster / Pivotal HD |
| Maintain the *Diractory Structure I
WOC writes data in the *Directory i as mentioned below :
Structure mentioned below I :
e Ty 4

*Directory Structure: J
- [<staging_folder>/rsasoc/vl/sessions/data/<year>/<month>/
<day>{<hour>/

- [<staging folder>{rsasoc/v1/logs/data/<year>{<month>/<day>/
<hour>/

You can configure the Warehouse Connector service to write the collected data to a Hadoop-
based distributed computing system that supports WebHDFS.

Configure the Destination 13
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Configure the Destination Using NFS

Make sure that you have:
 Installed the Warehouse Connector service or virtual appliance in your network environment.

¢ Added the Warehouse Connector service to NetWitness. For more information, see "Add a Service to
a Host" in the Hosts and Services Getting Started Guide.

e Set up NFS on Warehouse Connector. For more information on how to set up NFS on Warehouse
Connector, see "Configure Warehouse Connector to Write to Warehouse" in the Warehouse (MapR)
Configuration Guide.

To configure the destination using NFS:

1. Log on to NetWitness.

A
2. Goto (Admin) > Services.
L XE

3. In the Services view, select the Warehouse Connector service, and select > View > Config.

The Services Config View of Warehouse Connector is displayed.

NETWITNESS Investigate Respond Users Hosts

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT SOURCES

£ Change Service |

Warehouse Connector | Config @

CMSENRL SRSIENONSl  Streams  Lockbox Settings  General  Appliance Service Configuration

Source Configuration

+

|1 name Address port
I logdecodert - Log Decoder 56004

| | logdecoden? - Log Decoder 56002

Files

HEALTH & WELLNESS  SYSTEM

Dashboard  Reports

SECURITY

Destination Configuration
+

) name

O nFs

O sFe

Type

sfp

On the Sources and Destinations tab, in the Destination Configuration section, click + .

4,
5. In the Add Destination dialog, from the Type drop-down list, select NFS.
6. In the Name field, enter a unique symbolic name for the destination.
Note: The Name field does not support spaces or special characters except underscore ().
14 Configure the Destination
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7. In the Local Mount Path field, enter the locally mounted directory for HDFS where you want the
Warehouse Connector to write the data. For example:
If /saw is the local mount point for HDFS that you have configured while mounting the

mapr NFS cluster on the host where you have installed the Warehouse Connector service to write to

NetWitness Warehouse (MapR), create a directory named Ionsaw01 under /saw and the
corresponding Local Mount Path for the destination would be /saw/Ionsaw01.

For more information, see "Mount the Warehouse on the Warehouse Connector" topic in the
Warehouse (MapR) Configuration Guide.

Add Destination

Type * NFS| v

MName *

Local Mount Path *

Cancel Save

The /saw mount point implies to / as the root path for HDFS. The Warehouse Connector writes the
data to /Ionsaw01 in HDFS.

8. Click Save.

9. (Optional) If you want to enable checksum validation, perform the following:

a4
a. Goto (Admin) > Services.
-

b. In the Services view, select the added Warehouse Connector service, and select > View
> Explore.

The Explore view of Warehouse Connector is displayed.

Configure the Destination
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS  SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

s ChangeService | decoder - Warehouse Connector | Explore ©

/decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

Zdecoder - Warehous...

2 5 decoder - Warehouse Connector (WARE...|

connections

deviceappliance
&[] connections

logs
&[] deviceappliance
rest
] logs
O & services
o rest
[au) storedproc
B[ services sy
B[ storedproc users
Bsys warehouseconnector
B users

B[ warehouseconnector

c. In the options panel, navigate to warehouseconnector/destinations/nfs/config. This is the name
of the destination and is dynamic.

d. Set the parameter i sChecksumValidationRequiredto 1.

NETWITNESS estigate sers Hosts Files Dashboard Reports admin v

HOSTS  SERVICES  EVENT SOURCES  ENDPOIN u & WELLNESS  SYSTEM SECURITY

& ChangeService |  Warehouse Connector | Explore ©

=Warehouse Connect... Iwarehouseconnecior/destinasions/NFS/canfig Warehause Connector (Warehouse Cannector)

isChecksumValidationRequired 1

B 5 Warehouse Connector (WAREHOUSE_CO...
root Jroot/testikaushal

B[] connections

B TJlogs

rest

subtype nfs

pe hdfs

B[ storedproc
BTsys
B Jusers
B[] warehouseconnector
[Jconfig .
B[] destinations
E[INFS
[Ceonfig
algsFe
BT sources
Ostats

B[] deviceappliance

e. Restart the respective stream.

16 Configure the Destination
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Configure the Destination Using SFTP

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the Warehouse Connector service to NetWitness. For more information, see the "Add a Service
to a Host" in the Hosts and Services Getting Started Guide.

For the SFTP destination type, the destination host should be listed in the /root/.ssh/known_hosts file
used by the ssh service (for example, sshd) running on the Warehouse Connector.

Add Destination from Warehouse Connector Host

To add the destination host to the /root/.ssh/known_hosts file, from the Warehouse Connector host,
initiate a secure connection to the destination host:

L.

Log in to the Warehouse Connector.

2. Enter ssh root@<SAWIP> or ssh username@<SAWIP>.
3.
4. Add the host key in the /root/.ssh/known_hosts file

Select Yes and enter the password.

Note: After you upgrade the Warehouse Connector, you must make sure that the destination host is
listed in the /root/.ssh/known hosts file used by the SSH service (i.e. sshd) running on the
Warehouse Connector. If you do not perform this action, the streams configured with SFTP in
Warehouse Connector will not start.

If you want to use SFTP to write data into the destination using SSH key-based access, you need to
configure SSH key-based access between the Warehouse Connector and the Warehouse host
or Hadoop node. For more information, see Configure SSH Keys below.

Note: If you want to enable checksum validation to validate the integrity of the AVRO files that are
transferred from the Warehouse Connector to the destinations, make sure that you generate the keys
without setting the passphrase and do a key exchange between Warehouse Connector and the
warehouse nodes.

Configure SSH Keys

To configure SSH key-based access between the Warehouse Connector and the Warehouse host or
Hadoop node:

L.

Generate SSH keys on the Warehouse Connector at the default location. Perform the following:
a. SSH to the Warehouse Connector.
b. Type the following command and press ENTER:

$ OWB_FORCE FIPS MODE OFF=1 ssh-keygen -t ecdsa -b 521

c. The command prompts you to enter the file in which to save the generated key.

Configure the Destination 17
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Enter file in which to save the key (/root/.ssh/id ecdsa):

d. Enter the file in which you want to save the key and press ENTER.

The command prompts you to enter and confirm the passphrase.

Note: If you want to enable checksum validation to validate the integrity of the AVRO files
that are transferred from the Warehouse Connector to the destinations, make sure that you do
not set the passphrase. Then, the below steps e, f, g, and h are not applicable.

Enter passphrase (empty for no passphrase):
Enter same passphrase again:

The public key is generated and is saved in the location that you provided.

Note: If the SSH key is not generated in the default location (/root/.ssh/id _ecdsa), you
need to configure the destination for warehouse connector through Explore view. For more
information, see To configure the destination through Explore view:.

e. Change the directory by entering the following command:
cd /root/.ssh/

f. Move the generated key to the below location:
mv ~/.ssh/id ecdsa ~/.ssh/id _ecdsa.old

g. Type the following command and press ENTER:

$ OWB_FORCE FIPS MODE OFF=1 openssl pkcs8 -topk8 -v2 des3 -in id
ecdsa.old -out id ecdsa

The command prompts you to enter and confirm the passphrase.

h. Enter the encryption passphrase.

i. Run the following command to change the file permission:

chmod 600 ~/.ssh/id ecdsa

j- Copy the generated public key to append to the remote Warehouse host or Hadoop node.
ssh-copy-id -i ~/.ssh/id ecdsa.pub root@<destination host ipaddress>
2. SSH to remote Warehouse host or Hadoop node as "ssh '<user>@<ip address>", if identity key
file is at default location.
or

SSH to remote Warehouse host or Hadoop node as "ssh '<user>@<ip address> -i
<identity file path>", If identity key file is not at default location.

3. Append the generated public key to the remote Warehouse host or Hadoop node's authorized keys list
located at ~/.ssh/authorized keys.

Note: Make sure that you copy the public keys to the Hadoop node and while copying the public
key ensure that you provide the login details of the user using which the WebHDFS destination
would be added.

18 Configure the Destination
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You can now securely communicate between Warehouse Connector and Warehouse nodes or Hadoop
nodes.

Configure Warehouse Connector to use SFTP destination

Note: If the SSH key is not generated in the default location (/root/.ssh/id ecdsa), you need to
configure the destination through Explore view. For more information, see To configure the destination
through Explore view:.

To configure the destination through User Interface:

1. Log on to NetWitness

QA
2. Goto (Admin) > Services.
L G

3. In the Services view, select the added Warehouse Connector service, and select > View

> Config.

The Services Config view of Warehouse Connector is displayed.
NETWITNESS n Respond rs Hosts Files ) rd admin v

HOSTS  SERVICES  EVENT SOURCES ND 5 HEALTH NESS  SYSTEM
& Changeservice |  Warehouse Connector | Config ©

Streams  Lockbox Settings ~ General  Appliance Service Configuration

Destination Configuration
+

pov— - ] == Type parn

56004 O nrs nfs

1 Iogdecoden - Log Decader 56002 0 s sfip

4. On the Sources and Destinations tab, in the Destination Configuration section, click + .

Configure the Destination 19
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S.

In the Add Destination dialog, select SFTP from the Type drop-down list.

Add Destination

Type * SFTP v
Mame *

Host *

Port * 22 o

Username *
Password/Passphrase Fk k& EIEE

Remote Path *

Cancel Save

In the Name field, enter a unique symbolic name for the destination.

Note: The Name field does not support spaces or special characters except underscore ().

7. In the Host field, enter the remote server IP address.
8. In the Port field, retain the default port, 22.
9. In the Username field, enter the SSH username.
Note: In the case of HortonWorks HD, ensure that the username is gpadmin and for password
based access the password for gpadmin should be used. For passphrase-based access, the
passphrase used to generate the keys for gpadmin user should be used.
10. In the Password/Passphrase field, enter one of the following:
B SSH password - If you are using SFTP to write data into the destination using password-based
access.
® SSH passphrase - If you are using SFTP to write data into the destination using SSH key-based
access.
11. In the Remote Path ficld, enter the path of the directory present on the SFTP server.
12. Click Save.
13. (Optional) If you want to enable checksum validation, perform the following:
Q
a. Goto (Admin) > Services.
b. In the Services view, select the added Warehouse Connector service, and select - > View
> Explore.
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The Explore view of Warehouse Connector is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS  SERVICES EVENT SOURCES ENDPOINT o3 HEALTH & WELLNESS SYSTEM SECURITY

# Change Service | decoder - Warehouse Connector | Explore @

Idecoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

=decoder - Warehous...
connections
5 decoder - Warehouse Connector (WARE...
deviceappliance
B[] connections

logs
6 deviceappliance et
B0 logs services
A0 rest storedproc
B[ Jservices s
B[ storedproc users
B0sys warehouseconnector
B[ users

[Jwarehouseconnector

c. In the options panel, navigate to warehouseconnector/destinations/sftp/config.

d. Set the parameter isChecksumvValidationRequired to 1.

NETWITNESS vestigate Respond sts iles ashboard Reports

HOSTS  SERVICES

& Change Service | Warehouse Connector | Explore &

— Iwarenouseconnecior/cestinations/SFTP/config v Warehouse Comnector (Warehouse Conmector) ~
= Warehouse Connect...

known hosts file

| & Warehouse Connector (WAREHOUSE_CO..

password e
B connections

root Jrootjtest
logs

Dllog isChecksumValidationRequired 1
.

[rest host 10.31.204.44:22
BT services wpe hdfs
B[] storedproc username root
B 0sys subtype sfep
B0 users

H13 warehouseconnector
Cconfig
B[ D destinations
BInes
a[dsFre
[Jconfig
B 0sources
[stats
&[] deviceappliance

< >

e. Restart the respective stream.
To configure the destination through Explore view:

Q
1. Goto (Admin) > Services.

2. 1In the Services view, select the added Warehouse Connector service, and select
> Explore.

admin v

admin v

> View

Configure the Destination
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4,

The Explore view of Warehouse Connector is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

-+ Change Service | decoder - Warehouse Connector | Explore ©

/decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

=decoder - Warehous...

& decoder - Warehouse Connector (WARE...

connections

deviceappliance
[ connections

logs
&[] deviceappliance rest
a D logs services
B0 rest storedproc
[ services sys
£ [Jstoredproc users
B0sys warehouseconnector
B[Jusers

©[Jwarehouseconnector

Right click on "warehouseconnector" node and select properties.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

% ChangeService |  decoder - Warehouse Connector | Explore @

Iwarehouseconnector decoder - Warehouse Connector

= decoder - Warehous...

& £ decoder - Warehouse Connector (WAREH...

config

stats
[ connections

£ [ deviceappliance

B[ Tlogs

B[ rest

B [Jservices

&[] storedproc

B[ sys

B[ users

& &3 warehouseconnector
[config !
[Tstats

Properties for decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) /warehouseconnector.

add| v| Parameters

Message Help
Add a source, destination or a stream to this archiver.
security.roles: warehouseconnector. manage
parameters
source - <string, optional, {ip-address:The value must be an IP address and port in the following format: [ip-address]:[0-65535]}> The connection endpoint (ip:port) of a NetWitness -

Response Output

»

Select "add" property and manually enter the below config parameters.

name=<destination name> destination=sftp://<destination path>
host=<destination host ipaddress:port> type=hdfs port=22
username=<username> password=<password> privKeyFile=<private key file path>

22
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Aggregate Metas and Raw Logs for a Log Session

To aggregate raw logs and metas from Log Decoder into a single AVRO file instead of two folders.

L.

Go to ADMIN > Services.

Select a Warehouse Connector service and click £ C > View > Explore.
The Explore view for the Warehouse Connector is displayed.

Open warehouseconnector/streams/<stream name>/loader/config and in the right pane,
select the export.logAndsession.avro.enabled parameter.

Change the value to yes.
Restart the service.

Go to ADMIN > Services.
{} —

On the Streams tab, select the stream that you want to reload.

Select a Warehouse Connector service and click > View > Config.

Click Reload.
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Configure the Destination Using WebHDFS

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the hostname (or FQDN) and IP address of the warehouse nodes and Warehouse Connector to
the DNS server. If the DNS server is not configured, add the hostname (or FQDN) and IP address of
the warehouse nodes and Warehouse Connector to the file in the host on which the Warehouse
Connector service is installed.

If you want Kerberos authentication between the warehouse connector and the warehouse cluster,
make sure that you perform the following:

e Kerberos Key Distribution Center (KDC) Server is configured in your network environment and
the Kerberos Keytab file is copied to the host on which you have installed Warehouse Connector.

e Kerberos authentication is enabled in the warehouse cluster.

If you want to enable checksum validation to validate the integrity of the AVRO files that are
transferred from the Warehouse Connector to the destinations, make sure that you generate the keys
without setting the passphrase and do a key exchange between the Warehouse Connector and the
warehouse nodes. You need to configure SSH key-based access between the Warehouse Connector
and the Warehouse host or hadoop node. For more information, see 'Configure SSH Keys' in
Configure the Destination Using SFTP.

24
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Configure Warehouse Connector to Write to SFTP destination
To configure the destination:

1. Log on to NetWitness.

QA
2. Goto (Admin) > Services.

3. In the Services view, select the added Warehouse Connector service and select
> Config.
The Services Config view of Warehouse Connector is displayed.

NETWITNESS e  Respond es  Dashboard  Reports o,

HOSTS  SERVICES  EVENT SOURCES i s HEALTH & W

& Change Service | Warehouse Connector | Config.

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Source Configuration Destination Configuration

+ +

1| neme Address port 1 Name Type Path

J 1 logdecoder! - Log Decoder 56004 0 NFs nfs froot/test/kaushal
[ 1 logdecoder2 - Log Decoder 56002 O srp sfrp froot/test

4. On the Sources and Destinations tab, in the Destination Configuration section, click + .

5. In the Add Destination dialog, select WebHDFS from the drop-down list.

Add Destination

Type * WebHDFS ~
Mame *

Hadoop IP *

<

Hadoop Port *

Username *
Hadoop Path *

Kerberos Authentication [

Cancel Save

6. In the Name field, enter a unique symbolic name for the destination.

Note: The Name field does not support spaces or special characters except underscore ().
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7. In the Hadoop IP field, enter the namenode IP address of the warehouse cluster.
8. In the Hadoop Port field, enter the base port that is used by the namenode web user interface.

9. In the Username field, enter the owner of the directory in the warehouse to which Warehouse
Connector should write the data.

10. In the Hadoop Path field, enter the path of the directory in the warehouse to which Warehouse
Connector should write the data.

11. Select the Kerberos Authentication checkbox, if you want the warehouse connector to securely
communicate with the warehouse using Kerberos authentication.

Add Destination

Type * WebHDFS w
Mame *

Hadoop IP *

L

Hadoop Port *

Username *
Hadoop Path *

Kerberos Authentication [+

Kerberos Principal *

Kerberos Keytab File
Path *

Cancel Save

Perform the following:

a. In the Kerberos Principal field, enter the KDC Principal used for Kerberos authentication.

b. In the Kerberos Keytab File Path field, enter the path of the Kerberos Keytab file in the
Warehouse Connector.

12. Click Save.

13. (Optional) If you want to enable checksum validation, perform the following:

<4
a. Goto (Admin) > Services.
ﬁ v

b. In the Services view, select the added Warehouse Connector service and select > View
> Explore.

The Explore view of Warehouse Connector is displayed.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

TS  SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

% ChangeService |  decoder - Warehouse Connector | Explore &

o /decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

=decoder - Warehous...

connections

& decoder - Warehouse Connector (WARE...
deviceappliance

E[Jconnections

logs

B[ Jdeviceappliance rest

=0 logs services

HD rest storedproc

B[ Jservices sys

[ Jstoredproc users

B0sys warehouseconnector
B[ Jusers

[Jwarehouseconnector

c. In the options panel, navigate to warehouseconnector/destinations/webhdfs/config.

d. Set the parameter i sChecksumValidationRequired to 1.

NETWITNESS stigate Respond Users Hosts Files Dashboard Reports

admin v

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT SC HEALTH & WELLNESS  SYSTEM SECURITY

& ChangeService | Warehouse Connector | Explore ©

iwarehouseconnector/destinations/NFS/config Warehouse Connector (Warehouse Connector)

= Warehouse Connect...
isChecksumValidationRequired 1
2 & Warehouse Connector (WAREHOUSE_CO..
B[] connections
B[ Jlogs
B rest

B[ Jservices

subtype nfs

ype hdfs

& Jstoredproc
B0sys
B Jusers
B [Jwarehouseconnector
[T config «
B[ gestinations
ECINFS
E[JsFp
B[ sources
[Jstats
B[ deviceappliance

e. Restart the respective stream.
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Configure a Stream

You can configure the data stream to define the data source and destination combinations.

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the Warehouse Connector service to NetWitness. For more information, see "Add a Service to
a Host" in the Hosts and Services Getting Started Guide.

Configured the data source from which the Warehouse Connector service needs to collect data. For
more information, see Configure the Data Source for Warehouse Connector.

Configured the destination to which the Warehouse Connector service needs to write the collected
data. For more information, see Configure the Destination.

To configure the stream:

1.
2.
3.

Create a stream
Finalize the stream

Start the stream

Create a Stream

To create a stream:

4
Go to (Admin) > Services.

1.

2. 1In the Services view, select the added Warehouse Connector service and select & > View >
Config.
The Services Config view of Warehouse Connector is displayed.

3. Click the Streams tab.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT ES  HEALTH & WELLNESS  SYSTEM  SECURITY
4 Change Service | Warehouse Connector | Config

Sources and Destinations UGN Lockbox Settings ~ General  Appliance Service Configuration

O name Sources Destination status

O o running

4. On the Streams tab, click + .

Add Stream

Stream Mame * ||

Select Destination * Choose Destination ... w

Select Source *

O Name Address Port Session ID
O 56004 Enter Session
| 56002 Enter Session

Cancel Save

5. In the Add Stream dialog, perform the following steps:

a. In the Stream Name field, enter a name for the stream.

Note: The Stream Name field does not support spaces or special characters except underscore

Q).

b. In the Select Destination drop-down menu, select a destination from the list of destinations
added to the Warehouse Connector.

c. In the Select Source field, select sources from the list of sources displayed.
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d. In the Session ID column, enter the last session id.
If you provide any session id, the Warehouse Connector will start the aggregation from that
session, whereas if this is left blank, the aggregation will start from the current session.

e. Click Save.

Finalize a Stream

To finalize the stream:

A
1. Goto (Admin) > Services.
£ -

2. In the Services view, select the added Warehouse Connector service and select > View >

Config.
The Services Config view of Warehouse Connector is displayed.
3. On the Streams tab, select the stream that you have created.

NETWITNESS vestigate S sers sts ashboard Reports admin v

HOSTS  SERVICES  EVENT SOURCES  ENDPC OURCES  HEALTH & WELLNESS

+ Change Service | Warehouse Connector | Config &

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

O Name Sources Destination Status

O ] 50002 running

4. Click Finalize.
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Start a Stream

Note: If you have deployed a Warehouse Connector Virtual Appliance, make sure that you change the
default value of the Maximum Message Hold Count parameter to 800000. For more information,

see General Tab Settings.

To start the stream:

Q
1. Goto (Admin) > Services.

2. In the Services view, select the added Warehouse Connector service and select & > View >
Config.

The Services Config view of Warehouse Connector is displayed.

3. On the Streams tab, select the stream that you have created.

NETWITNESS vestigate Respon sers  Hosts iles  Dashboard  Reports admin v

HOSTS ~ SERVICES  EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS  SYSTEM  SECURITY
& changeservice | Rt | config @

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

¥ Name sources Destination Status

4 o 50002 stopped

4. Click Start.
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Monitor a Warehouse Connector

By monitoring a Warehouse Connector, you can automatically generate notifications when critical
thresholds concerning Warehouse Connector and its storage have been met.

To monitor a Warehouse Connector:

1.

QA
Go to (Admin) > Services.

In the Services view, select the added Warehouse Connector service and select

ﬁ..

> View

> Config.
The Services Config view of Warehouse Connector is displayed.

3. Click the Streams tab.

At the bottom of the Streams tab, click To configure the alert mechanisms related to the
Warehouse Connector navigate here.
The Warehouse Connector Monitoring view is displayed.

This page is deprecated and will be removed in a future release.

In the Source or Destination Status section, select the number of minutes or hours in the Notify
Offline For field.

You will receive a notification if the source or destination connection fails for the defined number of
minutes or hours.

In the Stream Status section, perform the following:

a.

In the Notify Stopped For field, define the number of minutes or hours after which you would
like to receive a notification when the stream goes offline.

In the Disk Is field, define the limit on the percentage of disk usage after which you would like to
receive a notification.

In the Source is Behind field, define the number of sessions. A notification is raised if the source
goes behind the defined number of sessions.

In the Rejected Folder Size is field, define the limit on the percentage of folder usage after
which would like to receive a notification.

In the Number Of Files in Permanent Failure Folder field, define the limit on the number of
files in the permanent failure folder after which you would like to receive a notification.

In the Notification Type field, perform the following:

a.

Click Configure email or distribution list to configure email so that you can receive
notifications in NetWitness. For more information, see the "Configure Email Server and
Notification Account" topic in the System Configuration guide.

Click Configure Syslog and SNMP Trap servers to configure audit logs. For more information,
see the "Configure Syslog and SNMP Settings" topic in the System Configuration guide.

Select the following notification mechanisms as per your requirement:
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¢ NetWitness Console - To get notifications on the NetWitness Ul notification toolbar.
¢ Email - To get email notifications.

* Syslog Notification - To generate syslog events.

SNMP Trap Notifications - To get audit events as SNMP traps.
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You must add Warehouse as a data source to Reporting Engine to make this data source available to
report against this Reporting Engine. For more information, see "Add Warehouse as a Data Source to
Reporting Engine" in the Reporting Engine Configuration Guide.
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Analyze a Warehouse Report

The Warehouse modules provide analysts with reports of early indicators of compromise. The following
Warehouse reports can be analyzed in NetWitness:

* Suspicious Domains report
e Suspicious DNS Activity report
* Host Profile report

For more information, see "Step 4. Analyze a Warehouse Report” in the Warehouse Guide.
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View the Warehouse Connector Service

While the information displayed in the Services System view is the same for all types of core services,
several options in the toolbar are relevant only for Warehouse Connector.

To access this view:

A
1. Goto (Admin) > Services.

2. In the Services view, select a Warehouse Connector and select 4
The Systems view for the selected Warehouse Connector is displayed.

> View > System.

NETWITNESS Inve: e Respond Users Hosts Files Dashboard Reports E admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

# Change Service | decoder - Warehouse Connector | System ©

8 Host Tasks () Shutdown Service ) Shutdown Appliance Service () Reboot

Warehouse Connector Service Information Appliance Service Information
decoder (Warehouse Connector) UNLICENSED decoder (Host)
12.0.0.0 (Rev null) s 12.2.0.0 (Rev null)
31128 KB (0.19% of 16046 MB) s 30392 KB (0.18% of 16046 MB)
3% 0%
2022-Sep-27 09:40:40 nning Sir 2022-Sep-27 10:07:53
1 day 3 hours 28 minutes 50 seconds ) 1 day 3 hours 2 minutes 42 seconds
2022-Sep-28 13:09:30 1 2022-Sep-28 13:10:35

Warehouse Connector User Information Host User Information

ne admin e admin

5rot Administrators el Administrators
connections.manage, logs.manage, services.manage, storedproc.execute, e appliance.manage, connections.manage, logs.manage, services.manage,
storedproc.manage, sys.manage, users.manage, storedproc.execute, storedproc.manage, sys.manage, users.manage

warehouseconnector.manage

Session Information

Session User IP Address Login Time ~ Active Queries

182 admin [:11:53094 2022-5ep-27 09:40:46 0

21 admin [:11:53098 2022-Sep-27 09:40:46 0

361 escalateduser 10.125.249.2:33690 2022-5ep-28 06:54:10 o

482 admin 10.125.249.2:33690 2022-Sep-28 12:29:46 0

517 admin 10.125.249.2:35348 2022-Sep-28 12:33:12 0 <

The following is an example of toolbar options for Warehouse Connectors.

B HostTasks (U shutdown Service (U Shutdown Appliance Service () Reboot

Host Tasks, Shutdown Service, Shutdown Appliance Service or (Shutdown Appliance), and Reboot are
common to all services and are described in the Hosts and Services Getting Started Guide.
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Troubleshoot the Warehouse Connector

The following information suggests the possible issues that NetWitness users may encounter when
adding a Warehouse service to the Reporting Engine as a data source for reporting in NetWitness. Look
for explanations and solutions in this section.

While adding a Warehouse service to the Reporting Engine as a data source for reporting, you may
observe some of the errors listed in this document. Information is provided on how to troubleshoot the
errors and add the data source successfully.

The following figure shows the New Service dialog.

Mew Service

Source Type * WAREHOUSE v
Warehouse Source * HiveServer2? w
Mame * PDH2.0-DCA

HDFS Path * /

Advanced ]

Host *

Fort * 10000

Username * gpadmin

Password kEEEEERE

Kerberos Authentication [+

Server Principal *

User Principal *

Kerberos Keytab File *
Enable Jobs ]

Test Connection

Cancel cave

For more information, see "Add Warehouse as a Data Source to Reporting Engine" in the Reporting
Engine Configuration Guide.
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_ Possible Solutions

Could not open connection e Ensure that the HiveServer2 is running on the Host.
to HiveServer

* Check if the port provided can be accessible from the Reporting
Engine server.

No Schema found in HDFS  Ensure that meta avro data file(s) are available in the HDFS path
path (<HDFS Path>/rsasoc/v1/sessions/meta) mentioned.

The following figure shows an example of the command to check the
files in hdfs.

Could not open connection  GSS initiate failed errors will be observed only in the case of Kerberos

to HiveServer, GSS initiate  enabled Hive.

failed Ensure that the proper keytab file is provided and it should have read
options for the rsasoc user (user on which the Reporting Engine Server
runs).
Ensure that the system time is synchronized between KDC, Hadoop
(HortonWorks) server, and the Reporting Engine system.

Add SFTP Destination

To add SFTP destination to Warehouse Connector, you need to follow the below steps:

1. SSH to NetWitness Host and run the following command to edit ssd_config file:
vi/etc/ssh/sshd config file

2. Do not comment HostKey/etc/ssh/ssh _host rsa key

3. You must append KexAlgorithms +diffie-hellman-groupl4-shal,diffie-hellman-
group-exchange-shal

4. Run the following command to restart NetWitness Host:
systemctl restart sshd

5. On Warehouse Connector Host SSH to NetWitness Host and run the following command:
ssh -o "HostKeyAlgorithms ssh-rsa" root@<NWhost IP>
For example, ssh -o "HostKeyAlgorithms ssh-rsa" root@10.10.10.10

6. Run the following curl command on Warehouse Connector Host to authenticate:
curl -vvvv sftp://root:netwitness@<NWhost ip>:22/root/
For example, curl -vvvv sftp://root:netwitness@<10.10.10.10>:22/root/

7. You can now add SFTP Destination from UI.
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Manage a Stream

You can manage a stream using the following procedures:
e Edit a Stream

* Reload the Stream

* Specify meta filters for a Stream

¢ Define multi-valued metas

Edit a Stream

You can edit a stream to perform the following:
* Add data sources to the stream.

* Delete existing data sources from the stream.
To edit a stream:

4
1. Goto (Admin) > Services.

2. In the Services view, select the added Warehouse Connector service and select

> Config.

The Services Config view of Warehouse Connector is displayed.

NETWITNESS Respond Users Hosts

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT § CES & WELLNESS

% Change Service | rehouse Connector | Config ©

MECENLLENENRIEE  streams  Lockbox Settings ~ General  Appliance Service Configuration

—

3. On the Streams tab, click lilr

4. In the Edit Stream dialog, you can perform the following:

Source Configuration Destination Configuration
+ +

[ ] Name Address Port [ Name

[ logdecodert - Log Decoder 56004 [ NFs

| logdecoder? - Log Decoder 56002 [ sFP

> View

admin v

Path
Iroot/test/kaushal

Iroct/test
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click Save.

Edit Stream

Stream Mame

Destination

Available Sources

L] Mame Address Port Session 1D

] 50004 50004 Enter Session

Cancel Save

e On the Current Sources tab, you can delete an existing data source from the stream. Select the

data source and click = .

Edit Stream

¢ On the Available Sources tab, you can select the available data sources to add to the stream and

5tream Mame

Destination

Available Sources

D Name

Current Sources

Address

U :50002

At least one source is required

Port

50002

Cancel Save

Manage a Stream
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Reload the Stream
When you reload the stream, the Warehouse Connector updates the schema file for the stream. You must
reload the stream when you add a new custom meta to the Log Decoder or Decoder.

To reload the stream:

4
1. Goto (Admin) > Services.
ﬁ W

2. In the Services view, select the added Warehouse Connector service and select > View

> Config.
The Services Config view of Warehouse Connector is displayed.
3. On the Streams tab, select the stream that you want to reload.

4. Click Reload.

Specify Meta Filters for a Stream

You need to specify the filter for each stream in the export.session.meta.fields parameter in the
Explore view of the Warehouse Connector.

The following table lists the values that you can provide as a filter:

e All the collected metas are written to SAW.

* metal, meta2 All the metas except the defined metas are written to SAW.
For example,
Filter:*, ip.src
All the metas except ip.src is written to SAW.

metal, meta2, meta3 Only the defined metas are written to SAW.

Note: By default, the following metas are written to Warehouse even if you specify them in the filter:
- ng_source

- unique_id

- time

To specify meta filters for a Stream:

4
1. Goto (Admin) > Services.

2. In the Services view, select a Warehouse Connector services and select L > View > Config.

The Explore view of the Warehouse Connector service is displayed.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

% ChangeService |  decoder - Warehouse Connector | Explore @

2= /decoder - Warehouse Connector (WAREHOUSE_CONNECTOR) decoder - Warehouse Connector

Zdecoder - Warehous...

& decoder - Warehouse Connector (WARE....
deviceappliance

[ connections

logs
£ [Jdeviceappliance
rest
B logs
g services
+] rest
O storedproc
e [Jservices sys
& [Jstoredproc users
B0sys warehouseconnector
B[ Jusers

& [Jwarehouseconnector

In the options panel, select warehouseconnector > streams > <stream_name> > loader > config.

4. Inthe export.session.meta.fields parameter, enter the filter.

NETWITNESS vestigate  Respond  Users osts  Files  Dashboard  Reports admin v
SERVICES ~ EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS VSTEM  SECURITY
% Change Service | Warehouse Connector | Explore ©
= \Warehouse Connect... Fwarehouseconnector/streams/ /loader/config | Warehouse Cannector (Warehouse Connector)
50002 10231
= & Warehouse Connector (WAREHOUSE_C... -
avraload.interval 3
B[] connections bulkcopy o
Bl logs destination.online 1
B0 rest exportlog.enabled yes
B0 services exportrollup hour
B0 sworedproc exportsession.enabled yes
B export.session.meta fields *
B users hold.count 100000
& [Jwarehouseconnector hold.interval 60
Dconig « holdsize 512 M8
B[ destinations loader.stats.interval 1
B[ sources page.size 200000
Ostars permrejected.number [
B[ streams rejected.size [
B[ Testing root Jresting
econfig thread.count 3
B loader thread pool.count 3
[config use.compression deflate
lstets wait.thread.pool 2
[schema hd
< >

5. Restart the stream.

Define Multi-valued Metas

You can also define an existing meta or a custom meta to be treated as multi-valued meta.
To define multi-valued metas:

Caution: Defining an existing meta to be treated as multi-valued may change the data type of the meta
and cause the associated reports to fail.
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3.

Create a new file with the filename multivalue-users.xml in the /etc/netwitness/ng directory.
Add the following entries:

<?xml version="1.0" encoding="utf-8"?>

<NetWitness>
<MultivValueMetas>
<Meta>NEWMETANAME</Meta>
</MultivValueMetas>
</NetWitness>

Where NEWMETANAME is the existing meta or a custom meta to be treated as multi-valued meta.

Caution: Make sure that you do not add metas that are by default treated as non multi-value.

Restart the stream.

View the current schema

You can view the current schema that is used by warehouse connector for writing in AVRO files.

To view the current schema:

a4
Go to (Admin) > Services.

1.
2. In the Services view, select a Warehouse Connector services and select L > View > Explore.
The Explore view of the Warehouse Connector service is displayed.
3. In the options panel, select warehouseconnector > streams > <stream_name> > config.
4. Set the value for refresh.schemanode.enabled parameter to true. By default, this value is set to
false.
NETWITNESS e Respo ser iles shboard Reports admin
SERVICES EVENT SOURCES
- Change Service |
= decoder14] - Wareh... config :I‘s:-t:\er‘_ﬂ-'.'n'z'shcuie(l:n'ecl:-'
B[ ] services 1000
B[] storedproc 0
a5y off
B[ Jusers destination i
B {5 warehousecannector
Ceonfiz handle.multivalue false
mcistl:a[ors heartbeat.error 120
B sources heartbeat.interval 10
max.pending 80
[etets
refresh.schemanode.enabled true
ag - behavior
sources fwiarehouseconnector/sources/ 10, 1 0T e T U ——
Dconfig state running
A eeder stream.data.path
Dscreme stream.id
Dsters stream.startpercent 0
5. Reload the stream. For more information see, Reload the Stream.
6. Restart the Warehouse Connector service.
) Ser
7. Go to E&H (Admin) > Services.
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8. In the Services view, select a Warehouse Connector services and select e > View > Explore.
The Explore view of the Warehouse Connector service is displayed.

9. In the options panel, select warehouseconnector > streams > <stream_name> > schema, to view
the current schema.

Note: You must to reload the stream every time, before you want to view the current schema or you
can add a scheduler to reload the stream automatically at regular intervals as mentioned in step 10.

10. (Optional) To reload the stream automatically at regular intervals, follow the below steps.

4
a. Goto (Admin) > Services.

b. In the Services view, select a Warehouse Connector services and select & > View

> Explore.
The Explore view of the Warehouse Connector service is displayed.

c. In options panel, select warehouseconnector > sys > config > scheduler. Right click and select
properties.

d. In the property drop down select addInter and in the Parameters text box, add "hours=24

pathname=/warehouseconnector/streams/<stream name> msg=reload'.

NETWITNESS Investigate Respond Users Hosts Files Dashboard e s admin

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

& Change Service | decoder141 - Warehouse Connector |  Explore &

fsysiconfig/scheduler decoderi4l

=decoder141 - Wareh...

B decoder141 - Wareha nnector (WAR..
[Jconnections

B[ Jdeviceappliance

B logs
B[ rest
B0 services Properties for decoder141 - Warehouse Connector (WAREHOUSE_CONNECTOR) /sys/config/scheduler.
B[ soredproc addinter v Parameters |hours-24 pathname-/warehouseconnector/streams! msg-reload I seno
By 4 Meszage Help
B config heduled task on an interval
[ scheduler a
o seconds - <uint32, optional, {range:1 to 31556326}> The number of seconds between executions, must provide one of seconds, minutes or hours -
[Jtasks
Response Output

B users
B warehouseconnector

Note: Standard time format used is hours. You can use seconds or minutes format in lieu of hours.

e. Then click Send.
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Manage a Lockbox

You can change the lockbox password, as well as refresh the lockbox.

Lockbox Status

Note: NetWitness Platform has added a Health & Wellness stat for Warehouse Connector to indicate
the status of its Lockbox. Also, an out-of-the-box rule has been added so that a Health & Wellness
alarm is raised when the Lockbox does not exist or cannot be opened.

Q
To see the rule details, go to (Admin) > Health & Wellness > Policies > Warehouse Connector
and select Warehouse Connector Monitoring Policy.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness

Policies Warehouse Connector: Warehouse Connector Monitoring Policy
+ Z1 B Rl el s s e et e peles e ke ety mesied P fepdy frrmEh s meeyiiem
¥ Enable Last Modified: 2019-04-29 03:15:00 PM

» [JESA Correlation

Services
» [(JEndpoint Broker Server
Choose the hosts, services, and groups that your health policy applies to.

» [JEndpoint Server

+
» CJHost
Name ~ Group Type
» (Jintegration Server 1 0 Al 20 Group
» [Jinvestigate Server
Rules

» [(JLog Collector
Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold
» [JLog Decoder 0 at which the alarm clears). After you define the alarm rule, enable or disable the alarm.

» [IMalware Analysis

» [JOrchestration Server 1 Enable Name ~ Severity Category Statistic Threshold
» CIReporting Engine O Lockbox Access Failure Critical Lockbox Lockbox Status Alarm 1= "0k’ for 0 MINUTES
O Warehouse Connector Serv...  Critical Processinfo Service State Alarm 1= 'started ready' for O MINUTES
» [(JRespond Server
O Warehouse Connector Serv...  Critical Processinfo Service Status Alarm 1= started for 0 MINUTES
» [ security Server
O Warehouse Connector Stre...  High Streams Stream Behind Alarm >= 2000000 for 0 MINUTES
» [JSource Server o
Warehouse Connector Stre...  High Streams Disk Usage (Pending Destination Load)  Alarm >= 75 for O MINUTES
45 Warehouse C: t -
& warehouse Connector Warehouse Connector Stre... ~ Critical Streams Stream Status Alarm 1= ‘consuming’online’ for 10 MINUTES
Warehouse Connector Monitor... O Warehouse Connector Stre...  High Streams Number of files in the permanent rej...  Alarm >= 300 for 0 MINUTES
» Cworkbench 1 O Warehouse Connector Stre...  High Streams Rejected folder usage in percentage Alarm >= 75 for 0 MINUTES -

To change the Lockbox password:
1. Log on to NetWitness.

A
2. Goto (Admin) > Services.
ﬁ -

3. In the Services view, select a Warehouse Connector service, and select > View > Config.

The Services Config view of Warehouse Connector is displayed.
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NETWITNESS westigate  Respond  Users  Hosts es  Dashboard  Reports o

HOSTS  SERVICES  EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

% Change Service | Warehouse Connector | Config ©

Sources and Destinations Streams Lockbox Settings ‘General Appliance Service Configuration

Source Configuration Destination Configuration

+ +

|| Name Address Port [0 name Type Path

I 1 logdecodert - Log Decoder 56004 [] NFs nfs froot/test/kaushal
[ 1 logdecodei2 - Log Decoder 56002 [] sFp sftp froot/test

4. Click the Lockbox Settings tab.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

% ChangeService | decoder - Warehouse Connector | Config @

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Create New Lockbox
Set the lockbox password. The password should satisfy lockbox password strength.You will be required to enter this password to perform any lockbox management.
Lockbox Password ok dkkk

Confirm Lockbox Password dricddedeokde

Apply

Change Lockbox Password
Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength
Current Lockbox Password ki
New Lockbox Password e

Confirm New Lockbox Password ~###ki

Apply

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password Hckk ko

Apply

5. In the Change Lockbox Password section, perform the following:

a. In the Current Lockbox Password field, enter the current lockbox password.

b. In the New Lockbox Password field, enter the new lockbox password.

Note: The lockbox password must be at least eight characters in length and it must contain at
least three of the following groups: one uppercase character [A-Z], one lowercase character [a-
z], one numeral [0-9], and one special character.
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c. In the Confirm New Lockbox Password field, enter the new lockbox password to confirm.

d. Click Apply.
The Lockbox password is successfully changed.

To refresh the Lockbox:
1. Log on to NetWitness.

A
2. Goto (Admin) > Services.

3. In the Services view, select the added Warehouse Connector service, and select

> Config.

The Services Config view of Warehouse Connector is displayed.

NETWITNESS e e Respond Users Hosts

HOSTS  SERVICES  EVENT SOURCES SOURCES  HEALTH & WELLNESS  SYSTEN

£ Change Service | Warehouse Connector | Config @

LM ENRL SRSIENBNNl  Streams  Lockbox Settings  General  Appliance Service Configuration

Source Configuration

+
[ name Address Port

1 1ogdecoder - Log Decoder 56004
[ togdecoden? - Log Decoder 56002

4. Click the Lockbox Settings tab.

Files

Dashboard Reports

SECURITY

Destination Configuration
+
O Name

[ NFs
O sre

> View

admin v

Path
Irect/test/kaushal

Iroot/test
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

# ChangeService | decoder - Warehouse Connector | Config @

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Create New Lockbox
Set the lockbox password. The password should satisfy lockbox password strength.You will be required to enter this password to perform any lockbox management.
Lockbox Password Fkkkhkk

Confirm Lockbox Password drikkdekk

Change Lockbox Password
Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password e —
New Lockbox Password ek

Confirm New Lockbox Password i

Apply

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password FhkRFERE

In the Refresh Lockbox section, enter the current lockbox password in the Lockbox Password field.

Click Apply.
The Lockbox is reset.
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Warehouse Connector Pre-Upgrade and Post-Upgrade

Steps

Pre-Upgrade Steps:

If NFS destination is configured, unmount the configured directory and disable the entry from /etc/fstab
using the command umount <directory name>

Post-Upgrade Steps:

1.
2.

Create a fresh lockbox key.

Reauthorize the user account in source configurations using using Explore or REST API.
Reauthorization of source user account is not available in UI. The command to reauthorize the user
account from Explore is given below:

> /warehouseconnector/sources/<source:port> ---> setPass property with
password=<password of the configured user in source>

. Reauthorize the user account in SFTP destination configuration from UL, Explore or REST API.

The command to reauthorize the password from Explore is given below:

> /warehouseconnector/destinations/<sftp destination> ---> setPass property
with password=<password of the configured user in SFTP destination>

If NFS directory mount was removed as part of pre-upgrade step, mount back the same
configuration. Additionally, enable back the mount entry in /etc/fstab.

> mount -t nfs -o nolock, tcp,hard,intr <IP Address for SAW>:/mapr/<cluster-
name> /<directory name>

Where <IP_Address_for_SAW> is the IP address of the primary Warehouse appliance in the cluster
and <cluster-name> is the name provided in the template file.
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Warehouse Connector Configuration References

This section contains descriptions of the user interface as well as other reference information.
e General Tab Settings

Appliance Service Configuration Tab Settings

Sources and Destinations Configuration

Add Stream Dialog

Streams Configuration

Lockbox Settings
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General Tab Settings

The General tab displays the general configuration settings for Warehouse Connector service.

Workflow

You are here

Install Warehouse Connector | Configure a Warehouse | Configure a Destination Add Warehouse as a Data

Service on a Log Decoder or _|_" Connector Service Source to Reporting
Decoder

Engine

Configure the Data Source Configure a Stream Analyze a Warehouse

for Warehouse Connector Report

Menitor a Warehouse
Connector

Manage a Stream and
Lockbox

What do you want to do?

(oS S TS

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SETP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide,

Administrator Manage a Stream and Lockbox Manage a Stream

*You can perform this task in the current view

Related topics

e Configure a Warehouse Connector Service

Quick Look

The following figure shows the General tab on the Warehouse Connector Services Config view.

The General tab displays the system configuration parameters for the Warehouse Connector service.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

%, Change Service | decoder - Warehouse Connector | Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

System Configuration

Name Config Value
Compression 0

Port 50020
SSLFIPS Mode ™

SSL Port 56020

Stat Update Interval 1000

Threads 20

Apply

When you add a Warehouse Connector service, default values are in effect. NetWitness designed the
default values to accommodate most environments and recommends that you do not modify these values
because it may adversely affect performance.

The following table describes the System Configuration parameters:
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m Config Value

Compression

Port

SSL

Stat Update
Interval

Threads

Determines the minimum amount of bytes before a message is compressed. If set to
zero, messages are not compressed.

Determines the port used by the service.

Note: If you change the port number, ensure that you restart the service.

If enabled, all the data transferred in the network will be encrypted using SSL.

Determines how often (in milliseconds) statistic nodes are updated in the system.

Determines the number of threads in the thread pool to handle incoming requests.
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Appliance Service Configuration Tab Settings

The Appliance Service Configuration tab displays the appliance configuration settings for Warehouse
Connector service. For more information, see "Appliance Service Configuration" in the Hosts and
Services Getting Started Guide.

Workflow

You are here

Install Warehouse Connector | Configure a Warehouse Configure a Destination Add Warehouse as a Data

Service on a Log Decoder or EENEN Connector Service Source to Reporting
Decoder

Engine

Configure the Data Source Configure a Stream Analyze a Warehouse

for Warehouse Connector Report

Menitor a Warehouse
Connector

Manage a Stream and
Lockbox

What do you want to do?

(oS S TS

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.
Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide,

Administrator Manage a Stream and Lockbox* Manage a Stream

*You can perform this task in the current view

Related topics

e Configure a Warehouse Connector Service

Quick Look
The following figure shows the different settings on the Appliance Service Configuration tab.

NETWITNESS Investi Respo ser osts Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

2, Change Service decoder - Warehouse Connector | Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Name Config Value
Compression 0

Port 50006
SSLFIPS Mode ™

SSL Port 56006

Stat Update Interval 1000

Threads 20

Apply

When you add a Warehouse Connector service, default values are in effect. NetWitness designed the
default values to accommodate most environments and recommends that you do not edit these values
because it may adversely affect performance.

The following table describes the Appliance Service Configuration parameters:
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m Configuration Value

Compression  Determines the minimum amount of bytes before a message is compressed. If set to
zero, messages are not compressed.

Port Determines the port used by the service.

Note: If you change the port number, ensure that you restart the service.

SSL FIPS If enabled, all the data transferred in the network will be encrypted using SSL FIPS.
Mode

SSL Port Determines the SSL port used by the service.

Stat Update Determines how often (in milliseconds) statistic nodes are updated in the system.
Interval

Threads Determines the number of threads in the thread pool to handle incoming requests.

56



Warehouse Connector Configuration Guide

Sources and Destinations Configuration

The Sources and Destinations tab for a Warehouse Connector in the Services Config view provides a
way to manage basic service configuration and configure source and destination.

Workflow

Add Warehouse as a Data
Source to Reporting

Configure a Warehouse Configure a Destination

Connector Service

Install Warehouse Connector
Service on a Log Decoder or
Decoder Engine

You are here
Configure the Data Source Configure a Stream
| for Warehouse Connector

Analyze a Warehouse
Report

Meonitor a Warehouse
Connector

Manage a Stream and
Lockbox

What do you want to do?

COR T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid
Administrator Configure a Warechouse Connector ~ Configure a Warehouse Connector
Service Service
Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector* Warehouse Connector
Administrator Configure the Destination using Configure the Destination Using
NES, SFTP, WebHDFS* NES
Configure the Destination Using
SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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o T T

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox Manage a Stream

*You can perform this task in the current view

Related topics

e Configure the Data Source for Warehouse Connector

e Configure the Destination

Quick Look

The following figure shows the Sources and Destinations tab on the Warehouse Connector Services
Config view.

NETWITNESS

HC SERVICES  EVE s ENDPOIN

% ChangeService |  Warehouse Connector |  Config

Sources and Destinations Stream: 1 Lockbox Settings General Appliance Service Configuration

Source Configuration Destination Configuration

+ +

[ name Address port O name Type patn

| ] logdecoder1 - Log Decoder 36004 [ NFs nfs froot/test/kaushal
[ 1 logdecoder2 - Log Decoder 56002 O sfp sfip J/root/test

The Sources and Destinations tab includes the following two sections:

Source Configuration
Destination Configuration

Source Configuration

The Source Configuration section allows you to configure the data sources from which the Warehouse
Connector service needs to collect data.

The following is an example of the Source Configuration section.
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Source Configuration
+

0 Mame Address

[ logdecoderl - Log Decoder

[] logdecoder - Log Decoder

Port
56004
56002

The Source Configuration section allows you to perform the following:

o i

Add the data source.

- Delete the data source.

Destination Configuration

The Destination Configuration section allows you to configure the destination to which the Warehouse

Connector service needs to write the collected data.

Destination Configuration
+
L Name Type Path
1 NFs nfs froot/test/
1 sFrP sftp froot/test

The Destination Configuration section allows you to perform the following:

CrICTT

Add the destination.

= Delete the destination.

i Edit the destination.
Note: You can only edit the SFTP destination
type.
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Add Stream Dialog
You can configure and add a stream to a Warehouse Connector in this dialog

Workflow

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Analyze a Warehouse
for Warehouse Connector Report

Meonitor a Warehouse
Connector

Manage a Stream and

Lockbox

What do you want to do?

(oS S T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SETP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream* Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide,

Administrator Manage a Stream and Lockbox Manage a Stream

*You can perform this task in the current view

Related Topics

e Configure a Stream

Quick Look

The following figure is an example with the important features labeled.

NERVRINESS) Investigate Respond Users Hosts Files Dashboard Reports admin v
HOSTS  SERVICES  EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS ~ SYSTEM  SECURITY
Groups Services
+ Fo - Z ¥ © | Filter X
Name \ Name Licensed ~ Host Type Version Actions
Sal o 1 ~
adminserver - Security Server adminserver Security Server 12.1.0.0 o3
adminserver - Source Server adminserver Source Server 12.1.0.0 o]
O archiver - Archiver archiver Archiver 12.2.0.0 E]
O archiver - Workbench archiver Workbench 12.1.0.0 &
broker - Broker broker Broker 12.2.0.0 &
concentrator - Concentrator concentrator Concentrator 12.2.0.0 Eed
O decoder - Decoder decoder Decoder 12.2.0.0 Ee]
™ decoder - Warehouse Connector decoder Warehouse Connector 12.0.0.0 []
endpoitEndponeseer —— Endpontseer [ven ]
Delete
endpointbroker - Endpoint Broker Server endpointbroker Endpoint Broker Servey Config Edit
m| endpointloghybrid - Concentrator endpointloghybrid Concentrator Explore Sieié
Logs Stop
O endpointloghybrid - Endpoint Server endpointloghybrid Endpoint Server Sty Restart
O endpointloghybrid - Log Collector endpointloghybrid Log Collector 12.1.0.0 &
O endpointloghybrid - Log Decoder endpointloghybrid Log Decoder 12.1.0.0 &
m] esaprimary - Contexthub Server esaprimary Contexthub Server 12.1.0.0 &
| Page 1 of2 | > I C Displaying 1 - 25 of 43

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOUR S ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

-+ Change Service | decoder - Warehouse Connector | Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

O V\Lim\n Sources Destination Status
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Add Stream

Stream Mame *

Select Source *
L] MName

O
O

Select Destination * Choose Destination ... "

Address Port Session 1D
56004 Enter Session
56002 Enter Session

Cancel Save

QA
Goto (Admin) > Services’

In the services view, select a Warehouse Connector service and select # © >view>config
In the Streams tab, click + to view the add stream dialog.
The following table describes the fields in the Add Stream dialog:

Stream Name

Select
Destination

Select Source
Name
Address

Port

Session ID

Type the name of the stream. The stream name may only contain alphanumeric
characters and underscores. It cannot exceed 20 characters in length.

Select a destination from the drop-down list.

Select a source from the grid at the bottom section of the dialog.
The name of the source.

The address of the source.

The port of the source.

The session ID of the source.
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Streams Configuration

The Streams tab for a Warehouse Connector in the Services Config view provides a way to manage
stream configuration.

Workflow

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Configure a Stream Analyze a Warehouse
for Warehouse Connector Report

You are here

Meonitor a Warehouse
| Connector

Manage a Stream and

Lockbox

What do you want to do?

(oS S T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SETP
Configure the Destination Using
WebHDEFS
Administrator Configure a Stream* Configure a Stream
Administrator Monitor a Warehouse Connector* Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide,

Administrator Manage a Stream and Lockbox Manage a Stream

*You can perform this task in the current view

Related topics

Configure a Stream

Quick Look

The following figure shows the Streams tab on the Warehouse Connector Services Config view.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

¢ ChangeService |  logdecoder] - Warehouse Connector Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

L1 Name Sources Destination Status

To configure the alert mechanisms related to the Warehouse Connector navigate here.

The Streams tab allows you to perform the following:

Description

+ Add a stream.

- Delete a stream.
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I

Edit the stream.

Start Start the stream.
Stop Stop the stream.
Finalize Finalize the stream.
Reload Reload the stream.

If you have added a new meta or if a new meta is added as part of content update to
any of the sources, Log Decoder or Decoder, you need to reload the stream for the meta
to be visible in the schema for the Reporting Engine. Reloading a stream does not have
any impact on the data, but only the new meta list is fetched from the sources.

The following table describes the fields in the Streams tab:

Name Name of the stream.

Sources The sources associated with the stream.
Destination The destinations associated with the stream.
Status Status of the stream.

Stream Statistics

You can view the statistics of a configured stream. Click the LiJ icon next to the name of the stream.

NETWITNESS

VICES

Lockbox Settings General Appliance Service Configuration

= | Stop  Reload | Change Configuration
¥ | Name Sources Destination status

11:50002

The following parameters are displayed in the Stream Statistics:

N

Stream
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e

Number of Determines the number of files in the permanent rejected folder
files in the (named, permfail) in the Warehouse Connector. The permanent
permanent rejected folder contains the files that Warehouse Connector failed to

rejected folder write to the destination.

Rejected folder Determines the disk usage of the rejected folder.
usage in
percentage

Session Rate Determines the rate at which the session is processed by the
Warehouse Connector for the source.

Destination
Status Indicates the status of the destination.
Source
Status Indicate the status of the source.
Sessions Determines that number of sessions that needs to be processed by the
Behind Warehouse Connector.

Last Session Determines the last session id processed by the Warehouse
read Connector.

Change Stream Configuration

You can change configuration of a stream in runtime. In the Streams tab, click Change Configuration
to change the configuration of the selected stream.
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Change Configuration :

Stream Configuration

Mame Config Value w
=l Aggregation Configuration

Ageregate max sessions 1000

Ageregation Interval 10

=l Loader Settings

Compress files on disk. deflate
Export Rollup Interval hour
Maxirmum Message Hold Count 100000
Maximum Message Hold Interval (Seconds) o0
Maxirmum Message Hold Size 512 ME
Page Size 200000
Remote Export Path !
Session Meta Fields Exported *
Session Remote Export [

=l Stream Settings

Auto Startup ]

Close Apply

You can change the following parameters of the Stream Configuration:

Note: If you change the value of any parameter in stream configuration, make sure that you restart the
stream.

After upgrading, if the values of Maximum Message Hold Count, Maximum Message Hold Interval and
Maximum Message Hold Size are 3000000, 60 and 128 respectively, ensure that you assign the
following values to the streams:

» Maximum Message Hold Count - 2400000
e Maximum Message Hold Interval - 600
¢ Maximum Message Hold Size - 512

You can assign these values by modifying the existing Stream configuration.
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Aggregate max
sessions

Aggregation Interval

Compress files on disk

Export Rollup Interval

Maximum Message
Hold Count

Maximum Message
Hold Interval
(Seconds)

Maximum Message
Hold Size

Remote Export Path

Aggregation Configuration

Determines the maximum number of sessions in a response for an
aggregation request from the Warehouse Connector to the source .

Determines the time between the responses from the source.
Loader Settings
Enable to compress files on disk.

Supported values:

¢ Deflate - Provides smaller compressed files and good performance while
generating reports.

o Off
By default, the parameter is set to deflate,

Determines the roll-up interval for export files and also the directory structure
the Warehouse Connector writes to the destination.

For example:

If the parameter is set to:

Value Directory Structure

hour /rsasoc/v1/[logs | sessions]/data/
{year}/{month}/{day}/{hour}

minute  /rsasoc/v1/[logs | sessions]/data/

{year}/{month}/{day}/{hour}/
{minute}
day /rsasoc/v1/[logs | sessions]/data/
{year}/{month}/{day}
If you change the value of the parameter, ensure that you restart the stream.
Recommended value is hour,

Determines the maximum number of sessions to store in the memory before
processing.

Note: If you have deployed a Warehouse Connector Virtual Appliance,
make sure that you change the default value of the parameter to 800000.

Determines the maximum time (in seconds) to hold the sessions in memory
before processing.

Determines the maximum size for the sessions to store in the memory before
processing.

Determines the remote local mount point for HDFS (nfs://) and the location
to export the data.

68



Warehouse Connector Configuration Guide

Page Size Determines the maximum pages.
Stream Settings
Auto Startup Enable to automatically start the stream whenever the Warehouse connector

process is restarted. By default, the parameter is set to off.
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Lockbox Settings

The Lockbox Settings tab for a Warehouse Connector in the Services Config view provide a way to
manage the lockbox settings.

Workflow

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Configure a Stream Analyze a Warehouse
for Warehouse Connector Report

Menitor a Warehouse
Connector

You are here

Manage a Stream and
Lockbox

What do you want to do?

(oS S TS

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.

Analyze a Warehouse Report" in the
Warehouse Guide,

Administrator Manage a Stream and Lockbox* Manage a Stream

Manage a Lockbox

*You can perform this task in the current view

Related topics

e Configure a Warehouse Connector Service

e Manage a Stream

Quick Look
The following figure shows the Lockbox settings tab on the Warehouse Connector Services Config view.

NETWITNESS | i R r Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

¢ ChangeService |  decoder - Warehouse Connector Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Create New Lockbox
Set the lockbox password. The password should satisfy lockbox password strength.You will be required to enter this password to perform any lockbox management.
Lockbox Password A AEII

Confirm Lockbox Password Fkdokkkdok

Apply

Change Lockbox Password
Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password i
New Lockbox Password i

Confirm New Lockbox Password ~ #######s

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password

Lockbox Password Fkk R,

The Lockbox Settings tab allows you to set, change, or refresh the lockbox password of the Warehouse
Connector.
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